4.02 Embossing and Scoring

4.02.1 General Info on Embossing

The Skycut embossing tool has two different sized embossing heads. The smaller one is recommended
when scoring cardstock for fold-up projects, such as pop-up cards, gift bags, and small boxes. Either head

can be used for embossing shapes.

When embossing cardstock, it is recommended that a soft material be place beneath the paper or cardstock
to allow a deeper impression to be made. One excellent material to use is non-slip shelf liner. Other
materials which can be used include rhinestone rubber, craft foam, and felt. Make sure the material is well
adhered to the mat (tape it down, if necessary). Then tape your paper or cardstock to the top of this
material.

When using the embossing tool for scoring fold-up projects, the paper or cardstock can be applied directly to
the mat, just as you do for cutting. This makes it much simpler when you need to score and then
immediately cut. Because the scoring may not be as deep on the underside of the paper or cardstock as the
top side, fold all score lines (valley and mountain) forward to establish the fold on both sides. Then flip over
and fold any mountain folds the opposite way. This especially works well on pop-up cards.

Make sure you do some tests first to get the best settings for the scoring or embossing you need. For
scoring cardstock, this typically involves a higher force (~75). If you have a soft material beneath your
paper/cardstock, then a lower force will be used. As with the test pen, use the 35 Post-It note method
presented in Section 2.01.3 to install the embosser into the Skycut.

4.02.2 Score and Cut Project

When a project involves both scoring and cutting, a process similar to what was used in Section 4.01.1 will
be followed. Because scoring normally requires multiple passes in order to get acceptable folds an
additional setting is required. There are other settings of interest that can also apply.

In this tutorial, a fold up box project will be used as a typical example. This small box file is provided in the
zip file available here.

Always make sure the project is organized so that you can easily select the score lines and the cut lines
separately. Click on the Objects tab on the Page Thumbnail Viewer and verify that the project is
organized as such. In this example, the score lines have been grouped together and the cut layer is just a
single object:
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[ Pages Objects

¥ “y [ zoom

Cut lines are on one layer ——p

|43 Curve, (35 Nodes) (1)

Score lines are on another layer ——»

£ Curve [x9] (18 Nodes.) (2}

After following the instructions from Section 4.01.1 to arrange the layers so that the score layer will be
conducted first, select that layer and click on the Edit option to open the following:

General Cutter Control Settings Tiling/Panels

SKYCUT V24 X
Vinyl Cutter (Piotter)
Preset Cutting Modes
Select Model SKYCUT V24
Preset Mode: b d
Media Width 24803 in =
Cutting Options
Small BoxTest Save )
Job Name Blade Preset Fold Tool e
Blade type Fold/Crease Tool w
() Rotate =
(O mirror [ Blade Offset ..;,uu v |
Overcut 0.00 = ’

) L 3. Enter all settings to be
General Options

Additional Options applied for the scoring
Tool Select Tool 0 v process
(] Registration Marks i
B Cutting Force 70 =18 g
Cutting Tool Presets . @ CuttingSpeed (6} 300 : p mm/s
Color Name Cutting Preset [JTravelSpeed  (5) 750 =TTy s
M Biack -
/ Golclen YcBow 1020) Cutting Options (selected contours) Fold/Crease Options
() None - Default
1' SeleCt bIaCk C]MLi.li-cul (thick media) A ? Iﬁ I|: 4 Make additional
layer O Dash cut g o0 | wm changes (Refer to
2. Click on | © Multi Fold/Crease Lines — Section 2.06.5)
Edit > ' Edit | () Thick Sheet (lift blade at corners)
M d—ik L .
e fony 5. Click on Apply

Note that if you will be performing score and cut projects regularly, setting up a Preset for your material will
make the selection of the settings much faster. Refer to Section 2.04.2.

Load the material into the Skycut and load the creasing tool with the small end downwards into the Skycut.
Move the tool to an appropriate origin. Click on Cut Now and you will be prompted to insert the tool:
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Load blade tool x

Please insert the following biade toot

Fold/Crease Tool

Click on OK and the scoring process will occur. A second prompt will advise you to insert the blade holder
which should done after the scoring is completed:

Piease insert the following blade toot

Drag Knife (45deg)

oK Skip

Click on OK and the cut lines will be made.

4.02.3 Embossing Paper or Cardstock

When embossing paper or cardstock, it is recommended that you use an Outline effect to create several
very small outlines at a thickness of, say, 0.01” (0.25 mm). These tiny offset lines will then produce a slightly
thicker overall outline of your shapes. This works better than line-filled embossing which can stress the

cardstock and cause wrinkling. Here are the steps:

O Create the shape you wish to emboss. In this example, the number 25 is used:

¢ Select the shape and click on the Plugins icon W Pugns and select Outlining Module. The following

window opens:
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5 Create Outline X

(|

3 5 . N
11 ToomToM  Toomin  Zoom Dut View Mode

. Outline: 0.010in (D %) Create OQuttine

Dutline Options
Corner Style [sharp
Dutline {%) IR :i
) T . »
Cuttine veon  4——— Set Size to 0.01
] eep Hotes
Reset

Output Options

[[Juse a Contour Cut (Dashed Outline)
use aFitcoior 5ot} [ ~

Images & Effects Options

[ incluce Images

[ include Effects

Click on Accept

— i

0 After clicking on Accept, use the Objects panel to select the new outline layer and repeat the process
to add a second outline. Now you have three versions of the shape, each one slightly outset from the
other. Thus, when using the embossing tool, this will result in a thicker outline made of this shape.

¢ Important: don’t forget to mark the Mirror option in the Send to be Cut window (or apply
Arrange>Mirror & Rotate>Mirror Horizontally) so that when you flip over the cardstock after
embossing, the design will “read correctly.”

4.03 Scratch Engraving

The Skycut engraving tool can be used to engrave vellum, foils, acrylic, and most metals, including trophy

labels, dog tags, and jewelry charms.

On softer metals, you may not want the engraving tip too far above the metal as it can leave pock marks
when it drops to start engraving. If possible, test on scraps first.

To design an engraving fill pattern, use the Engraving Module. Refer to Section 5.03

4.03.1 Engraving a Metal Tagq

o When engraving items that are already cut (such as metal tags, trophy plates, charms, etc.), it's very
important to have precise alignment before proceeding. Therefore, the camera on the Skycut will be used to
set the origin for engraving. If you haven'’t already calibrated the camera, go to Section 3.03.

e The following is a list of the items you'll need for this kind of an application:
0 The item to be engraved
0 The Skycut engraving tool

O Double sided tape to secure the item to the cutting mat. Thermo-web is perfect for this.
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Create a replica of the item to be engraved:

0 Ifit's something simple, like a square or a rectangle, use the basic shapes available in SignMaster:

Photo of actualtag  {hiih ‘ -

-~ Replica of tag created
using two circles

O Ifit's not a shape that can easily be recreated in SignMaster, then trace it onto paper:

¢ Scan or photograph the trace and use the instructions in Section 5.01 to import the scan and create a
contour of the heart:

Imported scan Tracing from Create
Contour Cut window

IMPORTANT: Carefully measure the actual tag and compare it to the dimensions of the contour. Adjust the
size of the contour if needed.

Create the design. In this case both text and a vector shape of a bone are added:

Because a filled engraving is desired, select the text and the bone shape and use the Engraving Module to
fill the design with lines. Details on this function are presented in Section 5.03.

Nikki
oup

To arrange the design in the bottom corner of the Page, click on Snap in the middle taskbar and select
Page:

111



Snap ~

Grid

Guides

|_U

Objects
Mark Page —_> v  Page

All

e With both the heart and the design selected, drag to the lower right corner until it snaps to the right and
bottom sides of the Page / Drawing Area (Note: to better illustrate placement on the page and later in the
Preview, the design has been made much larger. In reality the design is only about an inch in size):

. Nikki |

g > Snap the design to the lower

: " right corner of the page

o Select only the design and not the heart tag shape. In the Send to be Cut window, mark the option for

Absolute (position) so that the design will be positioned the same distance from the origin as it is from the
corner of the Page / Drawing Area. Also, verify that Assign Tools by Color is not marked:

Check Absolute (position)

SKYCUT V24, 24803 in

Rotate [ Advance After Flot I Biack Color (1/1)

Mirror B Absolute (position)
[ Use Top Left Origin

: <
General Options » g
il

[ Registration Marks [ Assign Tools by Color
- . =
Nikki w0
L o0
™

[ Auto Speed-Weed [T Auto Weed-Box ’ |
276 in

Verify Assign Tools by Design is in same location
Color is not checked as on the Page

e On the Cutter Control tab, uncheck Blade Offset as it's not needed when using the engraving tool:

General Cutter Control  sSettings

Uncheck Blade Offset  cutter Settings

T [ Biade Offset 0.40 0 F Passes |1 =l

[] Cut hales first Drag Knife (45deg) - Skycut 4

e On the control panel, click on the Speed/Force icon and enter a Speed of 10 and a Force of 40 for the
engraving. Note that with your own testing, you may need to alter these settings.
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The metal tag needs to be very firmly attached to the cutting mat. Place strips of double-sided tape onto the
mat, where the tag will be mounted:

Double sided tape is placed on the
mat to cover the size of the tag (note:
the pink liner hasn’t yet been removed
from the top of the tape)

I <

When placing the tag onto the mat, align the rightmost side of the tag with a vertical grid line and the
bottommost side of the tag with a horizontal grid line. The intersection of the two gridlines will be the origin
for the engraving process:

Align the tag with the grid
lines on the mat

\ The origin will be set at this intersection

Load the mat into the Skycut and be very precise in alignment by using the ruler to make sure the mat is
perfectly straight:

_ |
| A 4 ‘
- 5 g e Fd PPN, 1 . - [ <«——— Align the mat with the ruler

Load the engraver into the Skycut using ~30 Post-It notes (or sheets of copy paper), making sure the notes
are on top of the tag.

Move the cutting head so that the engraver tip is over the intersection of the two grid lines bounding the tag.
Then use the camera instructions in Section 2.05.1 to set the origin even more precisely by getting the blue
dashed + in the middle of the grid intersection:

S Blue dashed lines cross at

grid intersection

After clicking on Home, press down on the engraver and verify, once more, that the correct grid intersection
was used. Back in SignMaster, click on Cut Now and the engraving process will be carried out.:
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4.04 Settings Form for Accessory Tools

— . Speed
Application/iMaterial lool roree | D)
Application/Material Tool Force CutlU

Passes

Surface

Other Comments

© 2009- 2022 Sandy McCauley, All Rights Reserved
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5. SignMaster Functions of Interest

5.00 Quick Reference for Chapter 5

How to add a contour cut: Section 5.01
How to node edit a contour: Section 5.01.2
How to add a contour cut to a vector image: Section 5.02

How to fill a design with engraving lines: Section 5.03

5.01 Adding a Contour Cut Line to an Imported Raster Image

Graphics such as JPG, PNG, and BMP files are often used for print and cut (contour cut) applications.
Because these types of files are raster images (versus vector images), the images must be traced. This is
done through a process called vectorization.

5.01.1 Step-by-Step Tracing Process

The following steps are a sample tutorial using the Create Contour Cut feature in SignMaster:

(1) For this project, go to this link. After extracting, you will find several images that can be used as easy
samples for tracing.

(2) To import a graphic file, go to File>Import>File and select the graphic to be traced. Left click anywhere
in the Drawing Area to place the image:

@

-
-

(3) With the graphic selected, click on the Contour Cutting icon bt and select Create Cut Contour. A
popup window will open and you will respond Yes:

Confirm

Images detected, do you wish to include their auto-traced
contours?

I

(4) The Image Contour Tracer window displays the various settings available for adding a cut line to the
graphic:
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£ Image Contour Tracer

File Edit View

o b4
Image: 528 x 598 pixels (Has Mask)
Freview Settings
¥ opacity |« > 150
2 0
Trace Settings
Tolerance 16
< »
[ Use Image mask
[ uow Quatity (Fast} ] Tight trace
[C] Eait imape mask
Contour Options
Smcothing 50%

<
Min Size

<

[ e biotes

Click here to trace at
current settings

"\ Original {Composite [paskiCurves |

Trace Cancel

(5) Without making any changes, click on the Trace button to get a preliminary trace which will indicate
which settings, if any, need adjustment. The blue line indicates what will cut based on the default
settings shown:

@ ——__ Carefully check the blue cut line:

e Are all needed parts traced?

e |s trace line a tight enough
fit?

(6) To see the trace line a little more clearly, adjust the Opacity setting at the top. If the “fit” isn’t tight

enough, decrease the Smoothing setting. After making changes, click Retrace to return to the original
tracing window and then click on Trace again:

Increase Opacity to better see blue trace line
598 pixels (Has Mask)

Preview Settings

1 Opacity < > 2
c : ' _Decrease Smoothing
- — g [ErE Opkns for a tighter trace line
P R | Smoothing 50%
/ " ~
< >
é 1
= S Min Size 12 . .
/ Option to trace internal
/ < > .
. : parts if needed. Refer to
£ o Section 5.01.2.
/ \
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(7) After making any changes, click on Retrace at the bottom of the screen. On the other hand, if you are

(8)

happy with the trace results, click on Apply:

[
| ."
.‘\ ;
\
X /
Click on Apply if satisfied
with existing trace
( \
{ ‘an I
'\ Original | Composite (Mask/Curves < > " Retrace Apply Cancel

Click on Retrace to /

adjust to new settings

If you selected Retrace, a Composite view of the results will appear where blue indicates the part that

will be cut out and red indicates the waste material. You can go back to seeing the prior view by
clicking on the Original tab at the bottom. Click on Trace to apply the new settings.

Image: 528 x 598 pixets (Has Mask)

Preview Settings
& Opacity < >
f Trace Settings
2 Tolerance 47
-
< »
A use image mask
[Jlow Quality (Fast) [ Tight trace
[CJEdit image mask
Cantour Options
Smoothing 15%
< >
Min Size u
< >
E-iKeep Holes sk
v
\ Original | Composite f Mask./Curves [ < > £ Trace Cancel
Alternate viewing
options

(9) After clicking on Apply, a new group of settings appear, giving you additional options such as:

¢
0
¢
0

Whether the cut line is continuous or perforated

Whether the cut line fits the image tightly, or is offset a distance or inset a distance

Whether internal cut paths should be removed

The cornering shape of the contour cut (rounded, beveled, mitered, etc.)

Click on Trace
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o Create Cut-Contour

x
B
I:II Zoom To Ml Zoomin  ZoomOut View Mode
Outlne; 0.042in {1 %) Create Contour Cut (Outline)
() Build Contours ) Build Bowes
Ocutting arie Contour type options: use
Contour Type [ these settings
Cutting Contour b
Owttine Options
Corner Style Sharp
e s Contour shape options
Quttine (Units) 0042
[[] pashed Lines
[+ Heep Holes
Reset
Images & Effects Options
2] incuce Images Vectortze Original image options
[ inciuge Efrects

/ Click on Accept when done

Accept Cancel

¢ Choose a Corner Style, as desired. For the Outline % or Outline Units (size), note the following:
o Setto 0 if the cut line should align with the edges of the printed image
o Set to a positive number for a contour cut around the outside of the printed image
o Set to a negative number (normally very small) to cut slightly inside the printed image

(10) Click on Accept after making any changes and you will be returned to the Drawing Area. If you click

on the Objects tab on the Page Thumbnail Viewer, you will now see both the original image and the
contour cutline:

= Uasiad mage (528 x 533) (1

&4 Curee, (87 Hodes) (2)

e To print and cut this type of design, refer back to Sections 3.03 and 3.04.
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5.01.2 Editing a Trace

e Occasionally you may find a need to edit the tracing/contour cut created. This section presents two
examples.

e Contour cut doesn't fit the original graphic in certain spots

¢ In the following example, the Carfoon Owl image will be used:

¢ During the process of tracing, it was found that the bottoms of the owl’'s feet weren'’t rounded like in the
original image. Even trying different adjustments to Smoothing didn’t result in the desired fit. Note that
a slight inline was applied to improve the accuracy of the fit but the bottom of the feet still need
tweaking:

\ J \ J

Y Y
Trace line is flat along the bottom of owl’s feet

O With the trace line selected, click on the Node Edit Tools icon » and the nodes making up the path
of the cut will appear. Drag nodes, as needed, so that curves are formed:

KA

Drag nodes to create curves

e Contour cut contains paths you want deleted

O In the following example, a crab cartoon from Doodle Dragon Studios is traced:
. } Also needed is a trace of

‘o this area between the eyes
and the body

An outside trace is
needed —>

¢ The issue in this example is that the space below the eyes should be cut out but not other internal
shapes, such as the pupils of the eyes. Note the difference in what will be cut between marking and not
marking the Keep Holes option in the Create Cut-Contour window:
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smoocneg — Smocthimg

A W & =T ' ' . ; ‘r ’ > [keep e
o | A ' ( / 4
- versus
Area below eyes is traced but so Keep Holes No inner paths at all Keep Holes not
are the inner parts of the eyes checked checked

¢ The first option, Keep Holes, needs to be selected so that the area beneath the eyes is traced. After
accepting the trace, click on the Objects tab on the Page Thumbnail Viewer and hide the original
graphic. You will now only see the contour in the Drawing Area:

Pages Objects

A i - 'l ——,
Select this layer and w Oy 4/ I
click on Hide icon “——» N I B el
= | mags (1200 % BE3) (1) ‘ T L .

(%)

A |

£y Curve [x 5] (1068 Nodes.) (2

¢ Select the contour and go to Curves>Break Apart. The individual paths will now be separate layers on
the Objects tab and you can delete each one that is not needed:

Pages Dbjects

Paths inside of the
Path below eyes is eyes are gone
Delete these part of the contour cut

three layers .
&) Curve, (38 Modes ) (3} ‘

L4 Curve, (145 Nodes) (4}

£k Curve, (33 Nodes s (2)

|‘-I

£ Curva, (51 Nodes) (5) i

L)y Curve, (01 Nodes) (8)
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5.02 Adding a Contour Cut to a Vector Image

e As mentioned in Section 3.05.2, vector images require a contour cut assignment in print and cut
applications. For example, the following Batman SVG file is imported into SignMaster and then the Contour
Cut Wizard window is opened. Note that comparing the View Print only preview with the View Cut only
preview indicates that the vector file is ready to print but there’s no cut line for the design:

9.804 in
9.804 in

B.268 in 8.26:

;\Vnew Print orily {View Cut only | Tfeﬁ?ﬁ?iz{{} View Cut only [
larks Cancel Marks Cancel

What will print What will cut Opt|on to add contour cut

g

e There are two situations to consider:
¢ A contour cut will be added to follow the printed design (Section 5.02.1)
0 A contour cut will be added and it will be offset from the printed design (Section 5.02.2)

5.02.1 Contour Cut Which Follows the Printed Design

e Upon importing the SVG file, open the Objects tab of the Page Thumbnail Viewer to display the various
shapes in the file:

Click this blue__y « = = omes «———— Click the Objects tab
arrow ot (i 2 5 HAzoom

A

+ ~
Y- ;

E Group (Batman head PHC

mn .
m =

=I
- All of the shapes -

<

=. ii appear in a list £ Curve, (39 Nodes) (2)
ol |
: | HE
il
[
fm
.f £ Curve, (182 Nodes) (3)
iz}
N B
= i
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From the Objects list, click on the shape which represents the contour cut line you wish to use. In this
example, it is the black shadow layer:

With that layer selected, go to Edit>Duplicate. A new layer will appear at the bottom at the Objects list and,
thus, will now be arranged on top of the project:

o

This new layer will also be selected. To assign it as the contour cut, click on the Custom Fill icon
that is located on the Palette and select Cut Contour from the drop-down menu:

P Ybjects | 5 A Tooks
o B ¥ | Y9 Mioom | «B .
+ e
i, . T
Click here ———» w. — || vz

i ot oo 4_— Select Cut Contour

— Fold Contour
Perf Contour

SR
H N Em
W
1

,’ - Base Color (white)
- Registration Color
= ( Reverse Fill
| Wireframe Fill
-. ’ Custom Dashed Lines

This newly assigned contour cut layer is given an invisible fill color and will no longer appear on top of the
imported project.

&% Curve, (39 Nodes) (13)

If you now go to the Contour Cut Wizard, you can verify that this new cut layer exists on the View Cut
Only tab:
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10.685 in

Contour cut layer
now appears

A

Bin

View Print anly View Cut only
rks T Skip Print Cancel
What will cut

5.02.2 Contour Cut Which Is Offset from the Printed Design

e This section presents the method to be used when the contour cut is not one of the existing vector shapes.
While this section accesses the Create Cut-Contour window from within the Contour Cut Wizard window,
note that the same process can be applied by adding the contour from the main screen as was done in
Section 5.01 (i.e. select shape and go to Contour Cutting>Create Cut Contour).

o In the earlier screenshot, SignMaster recognizes there is no contour to cut on the View Cut only tab and
offers the option to add one using the Build button below the preview.

M A

9.804 in

8264 in

Tf.:;.-‘ﬁv:;f‘;{{; View Cut only |
o p—
What will cut Option to add contour cut

¢ Clicking on Build opens the Create Cut—Contour window:
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L §

11 ZoomToM Teamin  Zeom Out

View Mode

/ Click on View Mode to add the Outline preview

Cutine: 0.000 in (0 %)

Ouine: 0,000 1 (0 %)

°4

Create Contour Cut (Dutsne)

(®) Buid Contours () Buid Bases

() Cutting Grid

Contour Type

Cutting Contour

Dutline Optians
Comer Style
Dutline (%)
Outiine (Units)
[ Dashed Lines

[ e Hiokes

Images & Effects Optioes

[l tnchude tmages

[ include Effects

Round

Beset

Accent 4{

Use these options

Select a Corner Style

Keep at 0 for cut line
to follow print line or...
Increase to add a
contour cut or...
Decrease to add an
inset cut

Click on Accept when done

o Corner Style: Usually select either Round or Sharp depending on the nature of the original vector
and your desired contour

o Outline (%) or Outline (Units): Enter either a percentage or the actual size for the outline. In the
prior screenshot, leaving the Outline at O results in the contour being the same as the original
outside vector line. This would result in the same contour cut as was created in the prior Section
5.02.1. For an outset cut around the printed image, increase Outline to the desired size. For in inset
or inline cut, decrease Outline slightly so that it's a negative number:

=  Qutline is set to 1/8 (0.125) inch:

ine: 0.125in (2 %)

= Inline is set to -1/32 (0.03) inch:

Qutine: 0.125in (2 %)

A

®) Build Contours

Contour Type

Cutting Cantour

Create Contour Cut [Dutline}

Outline Options
Corner Styie
Custline (%)
Outline (Units

[ pashed Lines

[[] keep Holes

() Bulid Baxes
() Cutting Grig
Blue line shows size of
contour around original
Round
1.86% =
L Outline set to 0.125”
Reset

Images & EMects Options
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= -0.030n (0 %) Outine: -0.030 n (0 %) Create Contour Cut (Outtine)

(®) Build Contours () Build Boxes
| -IIII ) Cutting Grid
e - Contour Type
|
Cutting Contour v

Blue line shows size of
inline inside of original

A

Outtine Options

Corner Style .qpur.d
| | Outtine (%) -0.48% =
I f Quttine {Units) 20un4—=— Outline set to -0.03”

| ] Dashed Lines
[] keep Hobes

Reset

Images & Effects Options

O After clicking on Accept, the View Cut only preview now indicates a cut path exists and you're ready to
proceed:

9.804 in

Contour cut layer
now appears

A

8.268 in

n_;(_we«»-_?nr-! only \View Cut only

What will cut

Note that text is also a vector shape, thus the contour cut on a text object would be created the same way.

Also note that there is a Keep Holes option in the Create Cut-Contour window which controls whether or
not the contour is a solid outside cut or contains internal cuts following the shape of the vector:

A single blue line will

0 Keep Holes not marked: / be cut around the text

¢ Keep Holes marked:

Corner Style | Round
Outtime (%) |3.03%

Outtine (Units) |0.100
[[] Dashed Lines

Oree s ¢—— | eave unchecked

Reset
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Internal contour cuts are added

Duttine Options

Corner Style Found v|

Outiine (%) 3.03% =l

Oustine [Units) 0.100 in =

[ basied Lines

Hressie: 4——— Check Keep Holes

5.03 Engraving Fill

5.03.1 Engraving File Module and Settings

e If you wish tofill in a shape with a line pattern, SignMaster offers an Engraving Module which can be

% Plugins

opened by clicking on the Plugins icon and selecting Engraving Module.

e The following window opens and you will see your selected shape has already filled with lines:

Click to add original
shape to Preview

5 Creste Engraving Fill l %1

Zoom = : 2 [
tools ™ :m'r:m lw:ln szm v.-:wm
Toal Settings
Todlpath S-Sweep T
Travel | Horizontal
[ Cut Ferimeter
- - ———— Bt Engraving
X ' [T settings
Preview —|—» : Yook Diameter 00E R
Flange Offset |50.00%
] — Tod Offset E-Ju;
Hatch Offset [e500% il
Click on
Accept
when done

¢ In the top left corner are zooming tools. The View Mode icon can be toggled to add the original selected
shape to the Preview window, if desired:
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O Toolpath: There are four options in this menu:

o None: no fill pattern is created
S-Sweep: a line fill pattern in which the tool stays down while filling the entire shape:

O
2. Tool stays down, follows 1. Tool start here and
path of curve, then crosses proceeds to the left
to the right g / 3. Tool stays down, follows
i path of curve, then crosses
to the left, etc.
o Line Fill: a line fill pattern in which the tool raises at each side, moves a “row” down, and then
proceeds to the other side:
2. Tool raises 1. Tool start here and proceeds to the left
3. Tool drops and \4 — 4. Tool raises
proceeds to the right > « 5. Tool drops and proceeds to
the left, etc.
o Island Fill: a progressive inset pattern based on the original shape; the tool drops to complete a

path, raises, moves to the next path, drops to complete that path, etc. Some shapes work better
than others with an Island Fill:

0 Travel: four angles from which to choose, applying only to S-Sweep or Line Fill patterns:

Horizontal Diagonal - Up
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Vertical Diagonal - Down

0 Cut Perimeter: turn on this option if you want the original shape to be engraved as well:

Cut Perimeter: not Cut Perimeter:
checked checked
Perimeter of shape is Perimeter of shape is

g " light, indicating it will s _—~ dark, indicating it will
NOT be engraved also be engraved

¢ Cleanup Flange: turn on this option to have an engraving of the original shape, but along the edges of
the engraving lines. Note that there is also a Flange Offset setting which is a percentage distance from
the original shape to the engraving lines. These settings are typically not needed with small diameter
tools, like the Skycut engraver, so you most likely won’t have a need to activate Cleanup Flange.

0  Tool Diameter: The size of the engraving tip, pen nib, embossing tip, or other tool. For the Skycut
engraver, use 0.004 inch or 0.1 mm.

O Tool Offset: This setting is the distance between the engraving lines as a percentage of the Tool
Diameter. Lowering this setting will decrease the spacing between the lines:

Tool Offset: 34% Tool Offset: 15%

Engraving lines are

t much closer together

0 Hatch Offset: This setting controls the distance from the engraving fill to the outside perimeter of the
original shape, again as a percentage of the tool diameter. A setting of 0% will extend the pattern all the
way to the perimeter:

Hatch Offset: 35% Hatch Offset: 25% Hatch Offset: 0%
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5.03.2 Inside Fills Versus Outside Fills

e In certain situations, you might want to reverse the parts of a design that are filled. To do this, add any
outside shape to the design, such as a rectangle, an oval, a heart, etc. The engraving fill automatically fills
the space between this new outside shape and the original design.

O

0

For example, if three stars are sent to the Engraving Module, then they will immediately fill with lines
such as this:

If shapes are added around these stars, then the fill pattern reverses to fill the space between the
original shapes and the new outside shapes:

If another shape is added to the outside of these shapes (a large rectangle is added to encompass the

three shapes), then the fill will revert back to the original stars and a line fill is added between the
rectangle and the outside shapes that were added:

|

|

If, for some reason, you want the outside shape present but NOT have the area between the two shapes
filled, then only select the initial shapes (i.e., the stars) to send to the Engraving Module.
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Appendix A Troubleshooting FAQ’s

A1 Communication Issues

| cannot get the Skycut to power on.

e Make sure the power cable is securely plugged into the Skycut’s port on the left side and securely
plugged into a wall socket or a power strip.

o If it still fails, check the wall socket or power strip with another device, such as a table lamp.

e If you still cannot get the Skycut powered on, contact your dealer.

I cannot get Wi-Fi to work with my Skycut.

o Set the Skycut close to the router when performing the initial setup presented in Section 1.12.2. After
establishing communication, you can test how far the Skycut can be located from your router.

¢ In SignMaster’s Vinyl Spooler window, under the Connection tab, make sure you have selected TCP
and entered the same IP address you selected during setup on the Skycut’s control panel:

Settings

L\S (®) Port TCP “ Configure
192.168.1.200:3080

& O Printer

e Make sure your computer is connected to the same router as your Skycut.
o Verify that SignMaster is the selected software on the control panel under Set>Sys Information.

e |f the number you see on the control panel orange strip reads 192.168.16.254, you have NOT
connected to your router. That is the default IP address for a stand-alone connection. You need to
repeat the scan procedure and make sure you see the correct IP Address appear.

e  Some routers will not accept 200 or higher as an IP Address assignment. Try 151 instead.

e  Some routers assign the same name to both the 2.4G and 5G networks and because the Skycut's Wi-Fi
chip only works on 2.4G, you might need to rename your 2.4G network to a different name.

I cannot get USB to work with my Skycut.
e Unplug/replug the USB cable at both the computer and at the Skycut.

¢ In SignMaster’s Vinyl Spooler window, under the Connection tab, make sure you have Direct USB
Port selected under Port Type and the Status says Device Connected. If not, repeat the instructions
in Section 1.12.1.

Connection Method

e | O
Settings

§ Ussrort [ vid_o483&pia_57509skycut_368c

Status Device Connected
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